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s Put your most frequently used Word

Word documents right at your

fngerts documents right at your fingertips

At first glance, the My Places bar, which resides along the left side of both of the Open and
Save As dialog boxes, seems to be a helpful tool that allows you to access files faster. But
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Implement full volume Features
encryption to protect the unfortunately, this isn't always the case. The fact is, you may not use your My Documents - ‘
infor etion on stoe folder very often, and it likely takes numerous clicks to access your network folder via My + 4008 Building Better Microsoft Office Word
hard drives Network Places or My Computer. Although you can't expect Word to read your mind and 2003 Documents in Less Time
automatically take you to the precise folder you need, you can expect Word to allow you to
customize your My Places bar so that it fits your needs, as shown in Figure A.
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low-resolution web images anymore!
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2. Click on your folder so its contents
appear in the dialog box’s window,
and select the file you wish to open.

Note: Since the My Places bar is the same
in both the Open and the Save As dialog
boxes, you only need to format it in one
dialog box. When you make changes to the
My Places bar in one dialog box, they appear
in the other dialog box automatically.

Repeat the steps in this section to
populate your My Places bar with all of the
folders to which you want easy access.

To remove a folder from My Places:

1. Right-click on the folder you'd like
to remove.

2. Select Remove from the resulting
shortcut menu.

Note: Though you can remove any folder
that you've added to the My Places bar,
you can’t remove the default folders
from your My Places bar. These folders
include: My Recent Documents, Desktop,
My Documents, My Computer, and
My Network Places. You can put these
folders at the bottom of your My Places
bar, but if you truly want them out you
can remove them by editing the registry.
You can find out how to edit the registry
and remove default My Places folders by
searching Microsoft’s Help And Support
website, http://support.microsoft.com.

Size up your view

If you find yourself repeatedly scrolling
through the My Places bar to find the
folder you need, you can resize the Open

and Save As dialog boxes, or you can
resize the icons on the My Places bar.

To adjust the size of the Open and
Save As dialog boxes:

1. Open the Save As or Open dialog
box. Hover over the bottom-right
corner of the dialog box.

2. When your mouse pointer changes
to a double arrow, click and drag
to resize the dialog box (there’s a
minimum size requirement).

Your new settings are applied to both

the Open and Save As dialog boxes, and

are saved in Word so you won't need to

repeat this process each time you launch

the dialog box.

Resize the My Places icons

If you don’t want to resize the entire
Open and Save As dialog boxes, you can
resize the folder icons in the My Places bar
instead.

To increase the viewing area in the
My Places bar:

1. Right-click anywhere within the My
Places bar.

2. Select Small Icons from the
resulting shortcut menu.

Change the My Places
folder order

You can rank your folders by any means
you want.

To move a folder to the top of the My
Places bar:

1. Right-click on the folder you want
to move.

2. Choose Move Up from the menu.

3. Repeat steps 1 and 2 until the folder

is at the top of the My Places bar.
Unfortunately, each time you add a folder
to the My Places bar, it appears at the
bottom of the list. You have to repeatedly
select Move Up until your folder is in the
right place. @
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Adding your own folders to the My Places bar is simple in Word 2002
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In business today, productivity is key to your success. Whether that means setting up
projects for success, forecasting and analyzing trends, or managing critical business
information, it is vital that you have the skills to work at peak performance. You already
know how to use Microsoft® Office System applications. New Horizons offers Microsoft
Business Skills Series Courses to teach you how to use those applications to more efficiently
manage, work with, and prioritize information to make better decisions. Go to www.
NewHorizons.com for information on courses that cover topics such as:
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Implement full volume encryption to protect
the information on stolen Vista hard drives

You've undoubtedly heard the news reports of lost or stolen government laptop computers containing
confidential information. Of course, the problem isn’t limited to this sector. For example, corporate .
executives frequently travel with notebook computers containing company trade secrets and financial
information. Imagine the implication of those machines falling into competitors” hands! Furthermore, even
if the machine itself isn't stolen, it's relatively easy for someone with malicious intent to simply remove the
hard drive, slip it into his pocket, and walk away. Microsoft’s BitLocker Drive Encryption technology, which
is available in the Business and Ultimate editions of Vista, attempts to address problems like this.

Related Courses
5115 Installing and Configuring the Windows Vista™
Operating System

« 5116 Configuring Windows Vista Mobile Computing and
Applications

5117 Installing, Configuring, Troubleshooting, and
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Inside BitLocker

In brief, BitLocker uses 128-bit and
256-bit Advanced Encryption Standard
(AES) encryption to protect the volume
hosting the operating system. It can also
work in conjunction with Microsoft’s
Encrypted File System (EFS) so users can
continue to encrypt any personal data
that may also reside on the volume.
BitLocker provides three modes of
operation, as described here:

« Transparent Operation. This
mode leverages the capabilities
of the Trusted Platform Module
(TPM) 1.2 hardware to provide for
a transparent user experience. The
key used for the disk encryption
is sealed (encrypted) by the TPM
chip and is only released to the
OS loader code if the early boot
files appear to be unmodified. The

pre-OS components of BitLocker
achieve this by implementing a
Static Root of Trust Measurement,
a methodology specified by the
Trusted Computing Group.

User Authentication. This mode
requires that the user provides
authentication to the pre-boot
environment in order to be able to
boot the OS. Two authentication
modes are supported: a pre-boot
PIN that the user enters or an
inserted USB device that contains
the required startup key. Multifactor
authentication is also possible.

USB Key. This mode doesn’t
require a cryptographic hardware
chip, such as TPM. Instead, the
user must insert a USB device
containing a startup key into the
computer to be able to boot the

Maintaining Windows Vista®

« 5118 Maintaining and Troubleshooting Windows Vista

Computers
| B
r F

heroes happen {here}

protected OS. Note, however, that
this mode requires that the BIOS on
the protected machine support the
reading of USB devices in the pre-
OS environment.
For the purpose of this article, we'll focus
on the USB Key mode, as your current
inventory may not include machines with
the appropriate cryptographic hardware.
With that in mind, we'll walk you through
the basic setup, so you can prepare for
eventual deployment.

Mational Sponsor of the
Microsoft Launch Events

Partition your hard drive

Implementing BitLocker requires that
you partition your hard drive prior to
installing Vista. You need two partitions,
as described here:
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« System partition. Thisis a
relatively small partition that
contains the files needed to
bootstrap the machine.

«  Boot partition. This partition consists
of the remaining available space and
hosts the Vista operating system.

To partition your hard drive:

1. Boot the target system from the
Vista installation DVD.

2. Select the desired language, locale
(time and currency format), and
keyboard; click Next.

3. Click on the Repair Your Computer
link located at the bottom-left of
the display.

4. Inthe System Recovery Options
dialog box that appears, click in
the blank (white) area to deselect

Listing A:
Command sequence for partitioning a
hard drive to support BitLocker.

diskpart

select disk 0

clean

create partition primary size=1500
assign letter=S

active

create partition primary

assign letter=C

list volume

any operating systems that may
appear in the list; click Next.

5. Click on the Command Prompt link
shown in Figure A.

6. Inthe command prompt window,
enter the text shown in Listing A.

Format the partitions

At this point, you have two volumes:
Volume 1 is the system partition and
Volume 2 is boot partition, as shown in
Figure B. You now need to format both
partitions as NTFS.

To format the partitions:
1. Enter exit to quit diskpart.

2. Enterformats: /y /q /is:NTFSto
format the system partition.

3. Enterformatc: /y /q /is:NTFSto
format the boot partition.

4, Enter exit to close the command
prompt window.

5. Close the System Recovery Options
window.

Caution: Do NOT click the Shutdown or
Restart buttons; just click the Close box
to close the System Recovery Options
window.

6. Click the Install Now button.

7. Proceed with installing Vista,
making sure you choose the larger
partition, as shown in Figure C.

Enable BitLocker via 3. Inthe Group Policy Object Editor
Group Policy console tree, expand Local
) Computer Policy.
Because we aren’t using hardware
cryptography, we need to configure 4, Select the BitLocker Drive
Group Policy to support BitLocker. Encryption node.
Essentially, the policy we're creating 5. In the details pane, double-click
allows us to use the USB Key mode rather on the Control Panel: Enable
than TPM. Advanced Startup Options policy
item.

To enable BitLocker via Group Policy: 6. On the Settings tab, select the
1. Click the Start menu. Enabled option button as well
2. In the Start Search text box, enter as the Allow BitLocker Without A

gpedit.msc. Compatible TPM check box.

x
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Startup Repair
Automatically fix problems that are preventing Windows from starting

System Restore

Restore Windows to an earlier point in time

Choose a recovery tool

Operating system: Unknown on {Unknown) Local Disk

Windows Complete PC Restore
Restore your entire computer from a backup

Vista’s Pre- Windows Memory Diagnostic Tool
installation Check your computer for memory hardware errors
Environment (PE) ooy Command Prompt
includes several Open a command prompt window
system recovery Shut Down | Restart I
options.
[+ Administrator: X:\windows\system32\cmd.exe - diskpart - | E||5|
ISKPART> list wvolume
Uolume it Ltr Label Fz Type Size Status Info
Uolume B D LRMCFRE_EN_ UDF CD—ROM 2553 MB Healthy
Uolume 1 5 Ray Partition 1568 MB Healthy
Uolume 2 C RAY Partition 38 GB Healthy
ISKPART > =l

B Sis the system partition’s drive letter and C is the boot partition’s drive letter.




7. Click OKto close the dialog box, and
then exit Group Policy Object Editor.

Tip: You can activate the new policy
by either restarting the system or by
entering gpudate.exe /forceina
command prompt window.

Encrypt your hard drive
You're now ready to turn on BitLocker
and begin the hard drive encryption
process. Before proceeding with the
next group of tasks, make sure you

have a formatted USB flash drive at your
disposal.

To turn BitLocker on:

1. Select Start | Control Panel | Security
| BitLocker Drive Encryption.

2. Onthe page that appears, click on
the Turn On BitLocker link.

3. Inthe BitLocker Drive Encryption
dialog box shown in Figure D, click
on the Require Startup USB Key At
Every Startup link.

& A7 et Windows i
Where do you want to install Windows?
| Name | Total Size Free Space | Type |
= Disk 0 Partition 1 15GE 14 GB Primary
|_ + Disk 0 Partition 2 295 GB 297 GB Primary ‘
#4 Refresh Drive options (advanced)
&4 Load Driver C
You need to install
Vista on the larger
_ partition.

at certification.

Get a free Second Shot

To save the recovery key:

1. Insert your USB flash drive and wait
for it to mount.

In the next dialog box, select your
USB flash drive, and then click Save.

Note: Step 2 doesn't actually save the
recovery key. It saves the USB flash drive
selection only.

3. Inthe Save The Recovery Password
dialog box, click on the links to either
save or print the password.

4, Follow the prompts to save or print
the recovery key.

Tip: In addition to saving the recovery key
on the USB flash drive, you should save
it in an alternate location or

in the Encrypt The Volume dialog
box.

2. Select the Run BitLocker System
Check check box.

3. Insert your USB flash drive, and
then click Continue.

4. Restartthe computer when
prompted.

When the computer restarts, it checks to

see whether it can read the key stored on

USB flash drive. If the test is successful,

Vista boots and the volume encryption

process runs in the background. If it can’t

read the key, a dialog box notifies you

of the problem; in this case, the volume

encryption process doesn'’t start. @

print it because, without the
recovery key, you won't be
able to access the volume.

f= e

) Ly BitLocker Drive Encryption

Set BitLocker startup preferences

To encrypt the volume:

1. Carefully read the
information presented

D

This page reflects the
modifications you made
earlier through Group
Policy.

This computer does not appear to have a TPM. To use Bitlocker Drive
Encryption, a startup key on a USB memory device will be required every
time you start the computer,

% Require Startup USB key at every startup

o )
'0' Some settings are managed by your system administrator,
o

Cancel
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Export high-resolution web images with
Photoshop CS3

Anyone who's ever optimized web images knows that the struggle to maximize image quality Related Course
but minimize file size is often a fruitless battle. In the end, bandwidth dictates that file size usually
prevails and image quality suffers. But Photoshop CS3 comes to the rescue with the new Export to
Zoomify command. Now you can post high-resolution images to the web for an unparalleled end-user

Photoshop 7.0, CS, CS2 & CS3

experience. We'll show you how.

Whatis Zoom|fy? Yes, Zoomify is an application product,” states Zoomify in a dis- 2. Choose File > Export > Zoomify to
created by the company Zoomify, Inc.  claimer on their website. display the Zoomify Export dialog box.

Zoomify is a new export option bundled in ) ' ) )
According to Zoomify's website (Www. But that doesn’t mean you can't still 3

Photoshop CS3 that allows you to export
high-resolution images to the web. But
that’s not all: End-users can then zoom
and pan the image for an interactive

Select an option from the Template
pop-up menu to determine how

zoomify.com), the Export to Zoomify have some fun with this new feature!
command included in Photoshop CS3

is a beta version. This is where a little Let’'s zoom!

bit of bad news comes in. The Export
to Zoomify command “involves tech-
nology not considered ready for sale
or use on production websites and is
provided solely to support testing to
ensure a high-quality final shipping

You can't fully appreciate the Export
to Zoomify command until you see it

experience. When you use the Export to
Zoomify command, the mini-application
Zoomify breaks your image down into
image tiles that you store on your web
server with the rest of your web content.

in action, so let’s test it out. (Images
provided by PhotoSpin. Some images
modified for educational purposes.)

. . . To Export to Zoomify:
Graphic & Design eTips to Enhance L Mk _ bt
Your Work . ake sure your image Is o-pi

(Image > Mode > 8 Bits/Channel)
and in sRGB format (Choose Edit
> Color Settings, select sSRGB from
the Working Spaces RGB pop-up
menu). The Flash player requires
8-bitimages and sRGB format

IT Professional If you are an expert at what you do, then you want
Graphic/Design i . . ..
eb Developer to sign up for FREE New Horizons Graphics & Digital
ﬂomce ML Designer eTips. Each week you will receive expert advice
|
from our experienced editors that will improve your
productivity and enhance your work. Learn more about

the applications you use everyday, including: Adobe

Illustrator, Adobe InDesign, Adobe Pagemaker, Adobe will ensure consistent web color
Photoshop, Digital Photography and QuarkXPress. across Macintosh and Windows A You don’t have to settle for low-
Imagine the possibilities with the skills you'll gain! platforms. resolution web images any longer.
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Be aware of these Export to
Zoomify issues

While you're exporting your images,
keep in mind some of the following
known issues with the Export to
Zoomify command, taken from
Zoomify's website:

» Export dialog’s default quality
level should be at least 8:High.

» Export creates SWF inside
zoomable image folder rather
than at same level as folder.

« Exportdialog’s labels are
truncated in several places.

+ Export dialog Zoomify logo
background should not be
white.

» Viewer hang after extensive tile
loading.

« Pre-v9 Player should show error
instead of graphic effects.

+ Click-zoom when fully zoomed
conflicts with proper Reset
functioning.

« Background color does not show
on initial load (intermittent).

« Background white block appears
behind image on some zooms.

o  Scroll wheel scrolls window and
zooms image too.

For the complete list of known

issues, visit www.zoomify.com/

photoshop.htm.

your web page displays. We
selected Zoomify Viewer (Black
Background) for our example, as
shown in Figure B.

Tip: The options include different
colored backgrounds and the option
to include a navigation window or not.
The navigation window is similar to
Photoshop’s Navigation panel. For this
example, we find the navigation window
distracting to the image, but you should
test all the options to find your personal
preference.

4. Click the Folder button located
in the Output Location pane to
display the Choose The Output
Folder dialog box.

5. Navigate to an existing folder or
create a new one with the dialog
box options, and click Choose to
select your destination folder. We
set up a folder on our desktop for
this example.

6. Enter a name in the Base Name
text box. We entered mom__child
for our example.

N

Select High from the Image Quality
pop-up menu located in the Image
Tile options pane, and select the
Optimize Tables check box to
optimize the image tiles.

8. Enter width and height values in
the Width and Height text boxes
located in the Browser Options
pane. These settings determine
the size of your Zoomify window

Note: Zoomify specifically recommends
selecting the High setting because
of issues with the other settings. For
information on Photoshop Zoomify

known issues, see the pullout box titled after export. We entered 480 in

the Width text box and 600 in the
Height text box.

“Be aware of these Export to Zoomify
issues” in this article.

Zoomify™ Export

RGBSR v Zoomify Viewer (Black Background) 3 { oK }
outpul Zoomify Viewer (Gray Background) P o ——

Zoomify Viewer (White Background)

(_ Foldet  Zoomify Viewer with Navigator (Black Background)
Zoomify Viewer with Navigator (Gray Background) B e
Zoomify Viewer with Navigator (White Background) re——

Base Nan

Image Tile Options

Quality: |6 Medium ﬂ

@ Optimize Tables

Choose a Browser Options
background fOI’ Width: 400 | pixels Height: [500 | pixels
your web image # Open In Web Browser
in the Zoomlfy Zoamify C6FmOTe ST Snd Customizabi viewst a S 200 Com Bl with el
Export dialog box.
806 mom_child.html
| | e ][+ 2 fles//userssamy/Desktop/zoomify/mom_child.html  A(Q-

Zoom in to your high-
resolution image with
CS3’s new feature.
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9. Select the Preview In Browser
check box to launch your browser
and preview the zoomified image
after export, and click OK.

Host more than one
zoomified image

When you use the Export to Zoomify
feature, you receive a folder full of
tiles, plus an SWF player to preview
your image online. But what if you
want to host multiple zoomified
images on your website? Do you need
that same viewer on your web server
more than once? No. Zoomify suggests
you store the SWF player wherever
you like on your server and change the
‘SRC’ path of zoomifyViewer.swf in as
many places in your web page as you
have zoomified images. The Export to
Zoomify command exports the SWF
player each time you use Export to
Zoomify, but you need only one copy
on your web server.

Navigate the image

Now let’s take a look at the browser
preview, shown in Figure C. Use the
controls at the base of the image to
zoom in and out of the image. Click on
any portion of the image to zoom into
that area, or click and drag on the image
to pan around the image. Now, you can

D
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You can see how Zoomify breaks down your image by looking
at the image-tile thumbnails in Adobe Bridge. \_ Y,

Now take a look at the exported
image tiles for a better understand-
ing of how Zoomify breaks down the
image. For our example, the image
tiles are located in mom_child_img/
TileGroupO. As shown in Figure D, you
can preview the image-tile thumbnail

zoom in and preview high-quality image
details up close. Keep in mind, a high-
resolution image will allow you to zoom
in further than a low-resolution image.

Tip: Press [Ctrl][Shift] to zoom in, and
press [Ctrl] to zoom out.
previews easily with Adobe Bridge. @

f
Get Advice from the Experts —

Attend This FREE WEBINAR

ITIL - Wednesday, April 23rd at 9 am Pacific
(11 am Central, 12 pm Eastern)

The IT Infrastructure Library (ITIL) is the most widely
accepted approach to IT service management in the world.
Attend this webinar to learn from an ITIL professional about
the different library components, ITIL certifications and see
examples of how ITIL has led to high-impact success.

To register for this session and view the Webinar
archive, clickon www.NewHorizons.com/Webinars.
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